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Producing a Book Using TMG and Word 
 

By  Douglas Hill 
 
 
Presented to the Ottawa TMG Users Group meeting on 18 May 2008. 
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I.   INTRODUCTION 
 
4 Books about Publishing a Family History that were consulted:  
#1 & #2 are worth getting 
 
1. Susan Yates and Greg Ioannou, Publish Your Family History, preserving your family’s 
heritage in a book (Toronto: The Ontario Genealogical Society, 2005)  154 pp.   mostly about 
book design and printing, by two authors in the printing business.  
$25 from OGS.  
 
2.  John Townesend, Publishing Your Family History (Ottawa:British Isles Family History 
Society of Greater Ottawa, 2003).  24 pp.  covers the whole process.  $5  from BIFHSGO. 
 
Books 3 & 4 have conflicting opinions on style. 
 
3. Margaret F. Costello and Jane Fletcher Fiske,  Guidelines for Genealogical Writing, style 
guide for the NEHGR …(Boston: NEHGS, 1990).   22 pp.     
“in a book, the author should remain unobtrusive, letting his story seem to tell itself.  Direct 
personal observations and intrusions into the text, very popular in books written a century ago, 
are best avoided”  (p.17) 
 
4. Donald R. Barnes CG and Richard S. Lackey CG,  
Write It Right:  a manual for writing family histories and genealogies (Ocala, Florida: Lyon 
Press, 1983).  124 pp.   [do not write a]  



 2

“dull composition that is cold and impersonal.  Rather, limited primarily by your purpose, let the 
work reflect you and be full of life”  (p. 46) 
“Do not be afraid to draw conclusions, make observations, or even ask thought provoking 
questions”  (p. 47)     This is the style approach that I like to use.  
 
Before you start: 
As John Townesend wrote, “I had to ask myself if I had enough interest, energy, time and money 
to see the project through”. 
 
I planned to produce three documents over time: 
   
In Oct 2006 I allowed six months for writing a Family History, to be followed by a Family 
Supplement.    It has been 18 months so far.  The delays are due to the decision that this will be 
the only version of this family history that I will write, so time was taken to collect extra data & 
photos.  I will also produce a Family Supplement giving details of living people (my generation 
& younger) – to be distributed only in paper form & only within my immediate family group.   
 
Selected Basic Requirements: 
 

• Know, and state, who your intended audience is.  

• Choose a numbering system for Journal Reports:  

   I usa a custom version of the Record Format. 

• Make sure all pronouns references are unambiguous!   

• Cite sources as much as possible. 

• Deal with issues of  © , privacy, and sensitivity.   

• Have your manuscript read by someone else.  

• Develop a good section structure and then write/ revise sections as time permits.  

 
 II.   CONTENTS OF MY DRAFT BOOK 
 
Title – should include names, places and dates.  My book’s title is:  
 
 

The Families of J. Beverley Fraser and Elizabeth W. How  

 of Toronto, Canada 

Including their ancestors, descendants and relations  

from 1830 to 2008. 
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Structure 
 
A good outline of chapters and sections, developed early, has preserved my sanity – I can 
prepare & revise sections as new information and photographs become available, and when I 
have time to work on it.   
 

Contents 
  
 
 1. Introduction  
 
 2. The Family of John Beverley Fraser and Elizabeth Webber How  
 
 3. The Family of Philip Fraser and Mary Gray  
 
 4. The Family of William Burgess and Elizabeth Watt  
 
 5. The How and Deans Families  
 
 6. The  Tooze Family   
 
 7. Historical Trends and the Fraser – How Family  
 
 8. End Material and Name Index   
 
  Collection of Photographs and Images     center of book ?  
 
 
 
 
III.   BOOK CHAPTER ONE: INTRODUCTION 
 
These sections of my introduction chapter are the sort of things that other authors might wish to 
include in their own books.  
 
 
 
 
 
 
 
 
 
 
 
 

 
Chapter One 
Introduction 
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1.1  Key Persons Chart   with explanation 
 
1.2  Summary 
 
 This family history starts by discussing the lives of John Beverley Fraser, and his wife, 
Elizabeth Webber How.   John Beverley and Elizabeth married in 1909 in Toronto, Ontario, 
Canada and had three children:  John Beverley Fraser (Jr), Elizabeth Jane Hill (née Fraser), 
and Rosena Millicent MacIver (née Fraser).  Those children produced nine grand-children, four 
of whom still remain in the Toronto area.   
 
Since this book will be distributed to public libraries, we are protecting the privacy of these 
living grandchildren and their families by only listing their names.  More details of their lives 
will be circulated within the Fraser family in an unpublished “Family Supplement”.  
 
 The parents of John Beverley Fraser were George James Fraser, born 1841 in County 
Sligo, Ireland, and Jane Burgess, born 1841 in Woodstock, Ontario.  George Fraser and Jane 
Burgess were both of Scottish and Irish ancestry.  They raised a family of eleven children in 
Woodstock, Ontario.   All of their known descendants are listed in this book.   
 
 The parents of Elizabeth Webber How were Edward John How, born 1850 in 
Hammersmith, Middlesex, England, and Rosena Webber Tooze, born 1848 in Holcombe 
Rogus, Devonshire, England.   Edward How and Rosena Tooze were both of English ancestry.   
They raised a family of four children in Toronto, Ontario.   All of their known descendants are 
listed in this book.   
 
1.3    Outline of Book – a few paragraphs 
 
1.4    Families Found in this Book 
 
 All of the approximately 300 people included in this book are found in the index at the 
back of the book.  The following four families are discussed to a significant extent in this family 
history.    
 

DEANS  Descendants of Elizabeth Deans, born 1821 in Bath, Somerset, England, 
and Thomas How, born 1820 in Middlesex, England.   

FRASER Frasers (and one Frazer), mostly the descendants of George James Fraser, 
born 1841 in Ireland, and Jane Burgess, born 1841 in Woodstock, Ontario.  
They had eleven children.   The spelling Frazer is more common than 
Fraser in Ireland, where these Scots Irish Frazers came from.  

HOW Descendants of Thomas How, born 1820 in Middlesex, England, and 
Elizabeth Deans, born 1821 in Bath, Somerset, England. 

TOOZE Mostly descendants of Mark Tooze, born 1825 in Holcombe Rogus, 
Devon, England and Elizabeth Webber, born 1823 in the same town.  The 
surname Tooze is derived from Tozer, which is based on the occupation of 
one who tozes / teases / cards sheeps wool.   Tooze is a common name in 
Devon.   
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 In addition to the above families, the following seven families are listed 

or discussed to a lesser extent in this family history.  At least seven 
members of each family are known.     

 
BURGESS Descendants of William Burgess, born 1809 in Edinburgh, Scotland, and 

Elizabeth Ann Watt, born 1816 in Ireland.   
HEWITT Descendants of Foster Hewitt, born 1902 in Toronto, and Elizabeth 

Kathleen How, born 1903 in Toronto.  Foster Hewitt was the famous 
hockey broadcaster for the Toronto Maple Leafs.   

HILL Descendants of Elizabeth Jane Fraser, born 1915 in Toledo, Ohio, and 
Wilson William Hill, born 1913 in Toronto, Ontario.  The author is 
included here. 

MACIVER Descendants of Rosena Millicent Fraser, born 1923 in Toronto, and Ray 
Donald MacIver, born 1921 in Toronto.      

PERKINS Descendants of Thomas E. Perkins, born 1848 in Quebec, and Harriet 
How, born 1854 in England.  Thomas was also the professional family 
photographer for the Hows.   

SHILTON Descendants of Isabell Fraser (a granddaughter of George J. Fraser) and 
John “Jack” Tyler Shilton.   

TAYLOR Descendants of John Norton Taylor, born 1927 in Adelaide, Australia, 
and Catherine Elizabeth Fraser, born 1939 in Toronto. 

    
 
1.5   Points of Interest 
 comments about famous people in the book  
 
1.6   Notes to the Reader  
 
 This author does not expect a typical reader to “plow” their way through the whole book.  
Genealogy charts listing lots of people can be pretty boring, even to a family historian.  Rather, a 
typical reader is encouraged to look through the image sections and read perhaps five to ten of 
the life stories presented in the most detail.  The two old letters from the Deans family, 
transcribed in sections 5.4 and 5.5, are also worth a look.  The details and listings for certain of 
the remaining people might also be of interest to particular readers.  
 
    Naming and Numbering Conventions  
    Abbreviations 
    Place Names 
    Name Index 
 
1.7    Notes to Fellow Genealogists 
regarding types of sources consulted, which lines were traced back in detail and which were not; 
how far back I went, etc.  
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IV.   BOOK CHAPTER SEVEN 
 
 
 
 
 
 
 
 
 
 

 
 The term “social history” is defined, and then examples of the social history of my family 
are presented.  Two of the examples are the data on family size and on occupations and 
annual earnings, derived from the 1901 and 1911 censuses of Canada.   
 

7.1     Family Size 
 

Family Sizes over Five Generations of the Fraser – How Family 

Generation 
Number 

Examples of that 
generation on the 
Key Persons chart 

Decades when 
most of that 
generation 
were born 

Number 
of 

families 
counted 

Numbers of 
children 

Average 
number of 

children per 
family 

1 Douglas A. Hill 1940s – 1960s 8 0,1,1,2, 
3,3,3,3 

2.0 

2 Elizabeth Jane 
Fraser 

1890s – 1920s 11 1,2,2,2,2, 
3,3,4,4,5,5 

3.0 

3 Elizabeth W. How 1860s – 1880s 9 1,1,2,2, 
3,3,4,6,7 

3.2 

4 Rosena W. Tooze 1840s – 1860s 9 2,3,4,4, 
5,5,5,7,11 

5.1 

5 Elizabeth Webber 1810s – 1820s 4 5,7,8,9 7.3 
 
 

 
Chapter Seven 

Historical Trends and the  
Fraser – How Family 
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7.2     Occupations and Annual Incomes 
 
 

Occupations and Annual Incomes in the Fraser – How Family 

Annual Earnings Name Occupation 
1900 1910 

              FRASER 
George James Fraser deputy collector, Inland Revenue 

(1890 – 1913) 
$1000 $1000 

William P. Robinson traveller (i.e. salesman) $800  
Philip Fraser (Sr) shoemaker $500 $850 
                 HOW 
Edward John How  
(father) 

printer at The Globe $750 $988 

Arthur Sydney How (son) jeweller at a “factory” $400 $720 
Alfred Deans How   (son) tailor $300 not given 
                TOOZE 
William Oliver Taylor medical doctor $2000 not given 
              OTHERS 
various, not family 
members  

domestic servants and farm workers, 
getting free room and board 

$120 to 
$200 

 

 
The effect of inflation from 1900 to 2007 is a factor of 25.65,  
 so $1000 in 1900 inflates to $25,650 in 2007.      
 
V.   WRITING A FAMILY STORY (IN GENERAL)   
 

 
CONTENT/PRESENTATION NOTES  
 

Add side topics in boxes. 
Details bring the past to life.  
Test the text by reading it aloud.  
Break up the text with boxes, images, maps, etc.   
Recount the old time stuff:  before TV, old cars, outdoor plumbing, clothes, entertainment.   
Add paras on  things “now” vs “when I was a kid”. 
Rewrite (at least a week after the original writing).   
Maps help readers unfamiliar with where things are.  
Local archives may want old family letters, documents, or manuscripts. 
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VI.    SAMPLE CHAPTER WITH TMG JOURNAL REPORT 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 THIS CHAPTER PRESENTS THE DESCENDANTS of Philip Frazer and Mary Gray, the 
paternal grandparents of John Beverley Fraser.  The spelling change from Frazer to Fraser is 
based on records found;  this surname is spelled “Frazer” about three times more often than 
“Fraser” in Ireland, where Philip Frazer was probably born.  The chapter includes the one 
confirmed child of Philip Frazer and Mary Gray, namely George James Fraser.  Evidence 
concerning three other possible, but not proven, siblings of George James Fraser is presented in 
section 3.3.  As far as the next generation is concerned, George and Jane Fraser had eleven 
children: ten of them and their descendants are discussed in this chapter; the eleventh, John 
Beverley Fraser (and his descendants) has already been presented in chapter 2, so his information 
is not repeated here.  
 
 
3.1   List of Descendants of Philip Frazer and Mary Gray  
 
 This is a TMG Indented Descendant chart listing known descendants of Philip Frazer and 
Mary Gray.   120 people over 6 generations are listed in 4 pages.   
 
3.2   The Story of the Fraser – Gray Family 
   
This journal report is limited to 4 generations, since generations 5 & 6 are mostly living people.   
It contains 85 people consisting of 55 numbered descendants and 30 un-numbered spouses.   The 
numbering of these people starts with #5, since numbers 1 through 4 are used in the previous 
chapter and we are making the numbering continuous.  The section contains ten black-and-white 
head-and-shoulder images of people, and is 22 pages in length (as seen below).   
 
3.3   Possible Siblings of George James Fraser 
 
These two pages present evidence that three other people are likely siblings of George James 
Fraser, or possibly cousins.  Richard Lundeen of Toronto kindly provided this evidence.   
 
3.4   Images for the Fraser – Gray Family   

 
Chapter Three 

The Family of Philip Fraser  
and Mary Gray 

 



 9

These six pages, containing 15 images, are also seen below. 
In all, chapter 3 has 34 pages (4 + 22 + 2 + 6).  
 
Section 3.2, the Journal Report, in more detail. 
The JB Fraser line has been printed already in chapter 2.  To prevent it being printed again, we 
first remove the link from  JB Fraser (78) to his father George James Fraser (76).   
 (later on, we restore that link). 
 
Tags are set up to just print the primary version of the Birth, Marriage, Death and Burial 
(BMDB) tags in the first paragraph, with the Biography tag providing all the subsequent 
paragraphs.   
 
Important journal report options & why: 
General Tab: First reference number = 5 (the journal person #) 
  (chapter 2 used person numbers 1 through 4) 
Sources Tab: endnotes unique 
 Use endnotes, since footnotes waste space & you cannot turn off the ibid feature; use 
unique to avoid duplicate references 
Memos Tab: memos are embedded with parentheses (to make them appear where I want them) 
Exhibits Tab: embed primary image (a head & shoulders portrait), but no captions (not needed) 
Indexes Tab: [people] & [bride, groom &marriages (combined index)] 
Tags Tab: all types (will include biography); Primary events (to exclude alternate versions) 
Names Tab:  Child names: Honour name font styles  
  (this gives child names in bold, matching the parents) 
Miscellaneous Tab:  BMDB in separate para at start; the only other event is the Biography tag, 
which contains the life story.  
- suppress details for living people (for privacy) 
  
 
VII.   FIXING JOURNAL REPORTS IN WORD  
 
Fix margins & save as  Word 2002 document. 
 
 Photos in Journal reports are added by Edit > Links > select, select all photos in the list > 
check “save picture in document” >  Update now.  Then resize each photo.   
Left double click > Format Picture > size tab: lock aspect ratio, set width to 2”  
>Layout tab:  wrapping = square;  horizontal alignment = other 
 > Advanced: Picture position > horizontal = 0.0” to right of column.   
& vert. position = absolute  0”  below para.   
  move object with text,  allow overlap 
  Text wrap:  square, wrap text on largest side only. 
   Distance: set all 4 sides to 0.2”   
The anchor only shows when you click on the image.  The picture moves to the next page with 
its anchor paragraph.    
Place all images to the left of the text.   
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Note 1.  To be able to see and print images, which are “drawing objects”, set  
Tools > Options > Print > Include with document, check Drawing objects.    
Tools > Options > View > Show,  uncheck Picture Placeholders.   
 
Note 2.  Journal reports put into MS Word cannot accumulate endnotes across multiple reports.  
Thus, sources and memos listed as endnotes will appear at the end of each individual Word 
document, with the numbering re-starting at number 1 each time.   
 
 Name index  The toolbar icon to Show/Hide the ¶ markings also reveals the hidden 
markings used to index names.   
 The Name index is added by Word as follows:  
Insert > Reference > Index and Tables > Index > .. indented, 2 col, right align page numbers, 
select tab leader = dots,  Formats “from template”, Modify to change format if desired, & OK.  
 The Name index is a field which can be updated as often as needed at any time.   In  any 
report, tell the reader what is indexed & what is not: names in Visual Chartform charts and in 
“life story paragraphs” (i.e. biography tags) are not indexed.   
 
I find that the name and marriages indexes both work, but the place names index doesn’t work.   
 
VIII. Printing 
 
Administrative details (done in this order) 
a. get ISBN  - free at LAC web site (now 13 digits, prev. 10) 
b. get CIP (Cataloging in Publication) data  
  - free from LAC;  send draft book electronically 
c. maybe get Canadian Copyright – costs $50 ?   
d. bar code for back cover – Not needed 
  - only need if book to be sold in bookstores  
  - costs $80;  not sure where to get it  
Binding   
 - I am NOT considering these bindings: cerlox,  spiral bound, stapled thru edge, stitched.   
 - I am considering 
    - saddle stitched (center stapled with huge staples)   
    - perfect bound 
    - ota binding (modern variant on perfect bound) 
Other 

• Printer to design and produce the cover.  
• Paper size 8.5 x 11”; gutter allowance 0.3”  
• # pages to be a multiple of 8.   
• group colour pages in center to save money 
• some printers want a pdf  file 
• pdf colour may need adjustment (CYMK vs RGB) 

 
 


